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What is a laser cutter?

Motorised mirror on an X,Y axis

100W Carbon Dioxide Laser

Infrared

Follows VECTOR line work

Can cut paper, card, wood, acrylic

Metal can be etched only

Wood must be check with the supervisor first.

Q
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Is it dangerous?

Yes.
Fire Danger
Laser Radiation

— Burns
— Blindness

Safety Interlocks
No user serviceable parts
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Before you start

Ask the supervisor to use the laser cutter

Specify the material you want to cut... And the
size.

You will need to ask the supervisor to get a
HOT WORK PERMIT.

No cutting can be done until the hot work
permit is in place.

To stop the machine: Press the pause button
or simply lift the lid...
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Measure Twice, Cut Once!

You know the size of your design, yes? You’'ll need it!
Today we are cutting %2 A4 size — 148.5mm x 210mm in 4.5mm card

It is critical that you know both the material thickness and the size of your
material. Find out. Write it down. Q

The Edge



Ine...

-
O
(O
&
()

i -
s
Q

O

Ins

'/
Bed /
Honeycomb

N




Let’s start!

* Have the supervisor switch on the machine
* Place your material in the top left corner of
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Position the laser head

The Edge



Check the Focal Distance

Take the focus check device and place carefully into the channel on the side of the laser

head... It'll balance there. Don’t drop it!

Q
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Raise the bed... Carefully...

As the bed approaches the head, use individual button clicks to move the bed up
until it JUST touches the focus device, either knocking it off or causing it to move.

Q
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Put it back where it lives!
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Inside the front ledge of the machine!




Position the laser

Position the laser at the top left of the material to be cut.
Do NOT adjust the height....
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Shut the lid
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And move to the PC to setup the software Q
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Open Corel Draw
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Select File > ‘New From Template’

ﬂ CorelDRAW X7 (64-Bit) - Untitled-1

File

FLD @3 DM
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Edit View Layout Object Effects Bitmaps Text Table Tools
New... N - H g 19%
New from Template...

Open... D . % oo Units:E

Open Recent

Close

Close All

Save... Ctrl+S
Save As... Ctrl+Shift+S

Save as Template...

Acguire Image »
Search Content

Import... Ctrl+I
Export For »
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Choose ‘rayjet.cdt’ Template

New From Template

Jo

Filter

Templates

Local and Online

Designer Notes

o b

All

Advertisements
Brochures

Business Cards
Business Stationery
Catalogs

My Templates

Backup_of_TheEd...

rayjet.cdt
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Envelopse
Flyers
Greeting|
Letterhe
Menus

3 results
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File > Import

LY CorelDRAW X7 (64-Bit) - Untitled-1

File
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Edit View Layout Object Effects Bitmaps Text Table Tools Windc
New... Ctrl+N = ﬂ ﬁ'-] 19% -
New from Template... ) )

Open... Ctrl+0 :: 0 ) Qh loo  Units:| millimeters
Open Recent »

Close I w0 w0 0
Close All

Save... Ctrl+S

Save As... Ctrl+Shift+S

Save as Template...

Acguire Image
Search Conte

Import...

Send To

Publish Page to ConceptShare...

Print Merge »

Document Properties...

Exit Alt+F4
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Select your file...
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[ Import |v] [ Cancel ]
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Place the file in the top left corner

chairl cdr

w: 148,623 mm, h: 2100 mm
Click and drag to resize.

Press Enter to center on page.

Press Spacebar to use original position.

m

2|® o) @
Outline
¥ I - |

sapadosd 3alqo Iff

suopeLLoysuel] T,

pusig G Buideys (£

1abeuejy palgy wi

The Edge



File is imported
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Use the selection arrow

s | CorelDRAW X7 (64-Bit) - Untitled-1

Edit

View

Layout Object
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This is used to select items within the
program.

Use it to select the entire image by
click-dragging a box over it.
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Cut paths MUST have a RED Hairline
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LY CorelDRAW X7 (64-Bit) - Untitled-1

Check all cut lines are ok
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Add some text
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Use your Colours!
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Go to Preferences First

Print

X

General I Color I Composite I Layout I Prepress

Destination

Printer: IrSRayjet Engraver v2.4.2 | Preferences... |

Page: ’Use printer default (Landscape) v] Use PPD

Status: Default printer; Ready

Location: C:\ProgramData\Trotec\PrinterDriver.Rayjet\Trote:

Comment: [T Print to file

Print range Copies

@ Current document () Documents Number of copies: 1 =

*) Current page Selection

) Pages: 1 @l Collate
Even & Odd
[T] Print as bitmap: 250 ~| dpi
Printstyle: | CorelDRAW Defaults -| [ Save As... ]
[Page 1 “)
[ Print Preview ] oK ] [ Cancel ] [ Apply ] [ Help ]
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Setting up the Laser Cutter
m prrmra— | ;15’

Unlimited use

|2 Hairline

rayjet

Intensity °
1 I
! Skip %

—
Air assist o On.\ Off
Passes 9 EIEI
—-—

—_—
20 Speed

-
Plastics e
Power i
2% [9[0)

e 6mm Acrylic

Thickness o
|
-10 0 10 20

3 mm IQIJ jj
P o 0%

Auto Focus o O On
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Fire Or Fail!

e Beware!

* Incorrect settings will cause
a fire...

* Or a print fail... And you
still pay for the materials.
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Setting up the Configuration

o
|2 Hairline v | millimeters v] u] |__"?

royjet —

—
Plastics
6mm Acrylic
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Set the material
rayjet

Intensity o
I

Airassist @ on @
Ir assist On off
Passes o 2 EEI

——
—

» Plastics A
@ 6mm Acrylic e
Add new material ®)
Paper 160g/m m
Paper 80a/m m
Cardboard 650g/m | X |
Favd AEN Ame- ~ B
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Set the Thickness

- * Thickness J
: ‘%

i e CardboaardetirSOqu e ‘4’3 ‘ ‘ I
\f Thickness @
sem Q0] T,

AutFocusa,OO
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Auto Focus is ALWAYS off

Material Selection

.

o

Paper

ardboard 650g/m e

J

Auto Focus 0O

Why? This machine does not have a an auto
focus system. Switching on this setting will
cause a head crash. This is bad and will
require a service technician to rectify.
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Setup the cut...

Intensity 9
Colour Select H R
Cut o Engrave -J-  Skip X Operation Type
Air assist o On .\
Passes @ [ 2 [QlQ Times to repeat
- ———
Power Setting 0.0 20
Power Speed SpEEd <> Accu racy

30% | - 2% |

-20 -10 0 10 20
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What’s wrong here?

Intensity o
HE
Cut of Engrave -J- | Skip
Air assist o On ) Off
Power Speed
50 % |wPled 50 % |Pled

-20 -10 0 10 20
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Check the settings...
rayjet ———

9

Process Engraving Direction PY

t Standardr E g ﬂ
Le ﬁ i

LU Performance Details

¢ ommm@m—— O |

125 250 333 500 600 1000

[] Cutting Table < |

e L
Thickness |- E@ ————

Ordered Dithering Error Diffusion

I.-‘] PR R #m ["] Rotary Fixture
:.. ¢ ..‘ ... Diameter -‘w B
Black White Color ‘I!‘
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Verify your settings
ragjet ——

Material Group Paper v Quantity |1 EIE
Material Card 350 gsm 7 Job Start () Software Print Button
Thickness 3mm EE] @ Rayjet Start Button
Auto Focus ]
Intensity 0% ||/l

0% (oo
Process Standard -

Shoulder Medium

Halftoning Black White -
Engraving Direction Top Down -
Resolution 500 dpi -

Cutting Table B |— [;_]E
Rotary Fixture []]----- E@
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Upload your settings

rayjet T

Material Group Paper e m
Material Card 350 gsm v Jare Print Button
Thickness 3mm E@ tart Button
Auto Focus ]
Intensity 0% |2 <l
0% @@/l
Process Standard v
Halftoning Black White -
Engraving Direction Top Down >
Resolution 500 dpi -
Cutting Table B =
Rotary Fixture | | |----- ﬂ
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But..... ‘
ragjet - —_—

Quantity |1 I;E]

Job Start () Software Print Button &

® Rapjet Start Button

Process
Shoulder
Halftoning

Engraving Direction

Resolution 500 dpi

Cutting Table O |- ﬂ

Rotary Fixture
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When Configured, Hit OK!

Color I Composite I Layout I Prepress I 1% No Issues

ation
i [Rayjet Engraverv2.4.2 v] [ Preferences...
[Use printer default (| v] Use PPD [ T .-"
\ |
R Default printer; Ready 0 0 L"
T
ion: C:\ProgramData\Trotec\Printerl ( }' ‘\: J
9 xain!
nent: [ Print to file | ,
] | |
r (0 0}
ange
rrent document () Documents 1 —_—
rrrent page Selection ! !
IlL_llI Collate
("] Print as bitmap: 250 | dpi
'] [ Save As... l
[> 17 pages

t Preview OK ][ Cancel ] Apply
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Now load the print manager

ouble click this icon in the : 3 . 12:16 PM
' 1/05/2015
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The print manager...

rayjet _—

BPreview

Untitled-1 |

Process & ’ Standard

Material aroup ’ Paper

|
|
Material name ’Card 350 gsm ’
|

Resolution ]500 dpi

| & Move Job to Laser o

Leave these alonel

www.rayjetlaser.com

Press "Start” on Rayjet to process Untitled-1
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The print manager...
rayjet -_—

N

B Preview

Untitled-1

Process & ’ Standard

Material aroup ’ Paper

|
|
Material name ’Card 350 gsm ’
|

Resolution ]500 dpi

| & Move Job to Laser o

www.rayjetlaser.com

Press "Start"” on Rayjet to process Untitled-1
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Always use move job to laser

rayjet _—

5

B Preview

Untitled-1 |

Process Qo ’ Standard

Material aroup ’ Paper

Material name ’Card 350 gsm

Resolution ]500 dpi

Cu ngrave
E l

Power Speed

@ [0 © g
e e———

[ 1 | 1 1
-20 -10 0 10 20

ALWAYS Check

www.rayjetlaser.com
Press "Start"” on Rayjet to process Untitled-1
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V| Move Job to Laser

When previewing you should see the whole image with the colours you selected... Q
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Press start on the laser cutter!

lPress "Start” on Rayjet to process Untitled-1
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The Extractor

The HEPA grade air filter will
extract all smoke. Ensure it has

automatically come on by looking
for this light...
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The print job will start!




Keep watch!

* Keep an eye on the cut in case of fire or issues
with the print.

e Usually, all engraving starts first, then the
cutting.
* |[n an emergency, lift the lid to stop the cut.
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Complete!

The laser will move back to it’s home
position.

BEFORE you lift the lid:
e Use the keypad to lower the bed. This
prevents damage to the head when

removing material.
* Wait... at least 30 seconds for the
smoke to clear...




Carefully remove the work piece

And you’re done! Make sure you remove all cut
material.

If some material has dropped into the

honeycomb, alert the supervisor who will
remove it for you.
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Final Questions

What do you do if the lens is dirty?

What do you do if the honeycomb is not
located properly?

What do you do if the work piece catches on
fire?

What do you do if the machine makes unusual
noises?

Q
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